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 Protocol – Set of Rules   
 

Ethernet – Cabling standard for Home&Office 
 

 
Peer to Peer:  All Connections Same             No Server – PCs called Nodes 

 
Client to Server:  Most Connections Different   PCs, Server, Pherperials 
 

 
LAN – Local Area Network (Fiber Optics)   Rooms, Buildings, Campus  

 
 WAN – Wide Area Network  (Crosses Street)  County, State, Country, World  
 
 
Network Components:  
 

Phone Modem using conventional copper lines on poles or underground 
  Modem = Mo (Modulate) & dem (Demodulate) and is a Analog to Digital Device 
 
  All other connection systems use Network Interface Card (NIC)  &  special wiring 
 
   Hub  Connects PC to network pc1, pc2, pc3, pc4,       BWs sum to Total BWs 
        pc1+pc2+pc3+pc4=Total BW 
   Bridge Connects LAN1 to LAN2 Does not analyze & No re-routing * Same Protocols 
 
   Router Analyzes Messages Pac1, Pac2,  Re-Routes & Best Route – Determines Best 
 
   Gateway Connects LAN1 to LAN2      Connects Intranet to Internet * Different Protocols 
 
   Switch Connects PC to network pc1, pc2, pc3, pc4,    all PCs same as Total BWs 
        pc1=TotalBW, pc2=TotalBW, etc… 
Advantages or Benefits of Networks:  
 

Communication with others & Sharing Resources with others 
 
Topology : Geometric arrangement of a computer system. Common topologies: Bus, Star, and Ring: 
 
 Bus: cheap & easy to install   
 

Star: cheap & easy to install (HUB?)  
 

Ring: expensive & more difficult to install but much faster and can span large distances 
 
 
 

http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci212839,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci212080,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci212769,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci211796,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci212495,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci214117,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci212660,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci212294,00.html
http://searchsecurity.techtarget.com/sDefinition/0,,sid14_gci211705,00.html
http://computer.howstuffworks.com/router.htm
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci212176,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci213079,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci213156,00.html
http://www.webopedia.com/TERM/n/star_network.html
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Network Servers: Server is a PC providing special service dedicated for normally (1) jobs 
 
 Network Server TCP/IP – Transfer Control Protocol / Internet Protocol 
  Traffic and Security 
 
 File Server  FTP – File Transfer Protocol (Downloading and Uploading) 
  Storage and Backup 
 
 Web Server  HTTP – Hypertext Transfer Protocol  
  Browser and Internet and Storage 
 
 Mail Server  SMTP – SimpleMailTransferProtocol  *  POP – Post Office Protocol 
  Internal – POP  External – SMTP  
 
 Database Server:  Complex Protocol * Structured Query Language * Internet Bootstrap Protocol 
  Complex functions that allow the server to: fetch, as well as others, etc… 
 

One of the most popular Protocol  for LANs is called   Ethernet   (coaxial cable) 
 

Another popular LAN  protocol  for PCs is IBM   token-ring network.  (Circular) 
 
Dis-Advantages of Networks: 
 
 Dependency All in One if it fails all fail  Loss of Autonomy some fear networks 
 
 Expensive to install and maintain   Loss of Privacy an administrator knows all 
 
 Security is a concern all access data   Viruses & Worms cripple networks quickly 
 
Media for Networks:  POTS  –  Plain Old Telephone Service 
 

DialUp: telephone lines 
 
      ISDN:  phone packets 
 

DSL / ADSL:  phone packets  
 

Coaxial Cable: coaxial cable 
 
Direct (Wireless) no cable or wiring 
 
 
 
 
 
 
 

http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci512084,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci512084,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci881593,00.html
http://searchwebservices.techtarget.com/sDefinition/0,,sid26_gci213606,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci212839,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci212080,00.htmlhttp://www.webopedia.com/TERM/n/Ethernet.html
http://www.webopedia.com/TERM/n/PC.html
http://whatis.techtarget.com/definition/0,,sid9_gci870770,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci214310,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci211941,00.html
http://searchwebservices.techtarget.com/sDefinition/0,,sid26_gci212399,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci213915,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci213764,00.html
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci211806,00.html
http://searchmobilecomputing.techtarget.com/sDefinition/0,,sid40_gci213380,00.html
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Email Fundamentals:  ( Microsoft Outlook & QualComm Eudora ) 
 

Email is fast, permanent, easily attached, copy many persons, temporary storage of Electronic Messages. 
 
  Email Address:  User Name@Domain Name.Extension    Internal(POP/LAN)  External(SMTP/WAN) 
 
   Mailbox/Mailbox: Post Office Protocol - POP   Server/Server: Simple Mail Transfer Protocol - SMTP    
 
Top Level Categories or Extensions:  .gov, .mil .com, .edu .net, .org Countries & Misc’s  
 
   Remember  @ is used in Email.       Domain Name is Words       Internet Protocol (IP) is Numbers 
 
Email Username & Password:  username @ provider.ext  ########5 
 
Email Page Appearance:   ( Toolbars,  Panes,  Current Views,  are only a few of the options. ) 
 

Toolbars: Outlook Bar,  Folder List,  Menu,  Standard,  Advanced, Web, Status,   Preview Pane 
 

Send/Receive -Reply/ReplyAll/Forward -Attachments:Text/Image -Store/Delete -Folder/External 
 
Send:  Create or Compose an Email message using a standard Email message format: 
 
  To:      From:       CC:        BCC:       Subject:      Body:     Attachment: 
 
   Single Email Address,   Multiple Email Addresses ( ; or , ),   AddressBook (Contacts/Distribution List) 
 
Receive:   Various ways to receive Email messages especially in MS Outlook ( View > Current View ) 
      Status: New, Read, Reply, Fwded, Undeliverable, Attachment, Flagged, Hi/Lo Priority 
 
Reply/ReplyAll/Forward:  Automatically Switches  To:  &  From:  and includes  RE: in Subject Line 
 Normally a message is to be included with a R/RA/F and should follow standard format. 
 
Attachments:   Textual documents created previous to Email  & Graphics/ClipArt/Images of all sorts. 
 Attachments are very susceptible to viruses & hoaxes.  Do not open if sender is not know!!! 
 
Store/Delete: Email messages tend to pile up therefore it is best to store in folders or completely delete. 
 It is a good habit to frequently review and delete messages especially from deleted items. 
 
Folder/External Storage:  Most messages are stored on Mail Server but some messages stored on HD. 
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Viewing & Managing Email Messages: ( Right Click Message to Store or Delete ) 
 
 Boxes or Folders:   Inbox,    Outbox,    Sent Items,   Draft Items,    Deleted Items,   Recycle Bin 
 
Sent Emails are stored in Outbox until Exit or S/R hit.     Also,  are automatically saved by MS Outlook. 
 
-------------------- 
 
MS Outlook Functions: ( Outlook Today, Calendar, Contacts, Tasks, Notes, Journal ) 
 All functions have      View > Current View Option      for various appearances… 
 
Outlook Today:  Allows a quick overview of the week such as: appts, mtgs, tasks, Email boxes, etc… 
  Outlook Today is the only function that does not have a Current View Option. 
 
Calendar:  Allows for scheduling of appts, mtgs, tasks, etc…      Calendars “remind” & can be shared. 
  Double Click Appt Line for Form:  Details, Recurring, Invite Attendees, etc… 
Contacts:  Allows for detailed information about friends, relatives, customers, colleagues, etc… 
  Contacts make up the personal addressbook.   Distribution list is a subset of addressbook. 
 
  To add a new contact use Actions or Click on Contacts then Right Click on a,b,c, etc… 
 
Tasks:  Allows for detailed information to be stored about tasks, start&finish date,  progress…  To-Do! 

Right Click at task line to complete detailed form on tasks and progress. 
 

Notes:  Allows for brief and descriptive comment on whatever is needed. 
  Right Click anywhere in the Note area to enter Note.  Click anywhere to close note tablet. 
 
Journal:  Day by day activities recorded or record of activities within work, home, tracking, etc… 
----------------------- 
Sorting & Finding Messages:    (  Advanced Find:  RClicking  Function/Folder Bar  above message. ) 
 Sorting is done by clicking on From, Subject, Received…  Click on Find & Enter Criteria… 
 
----------------------- 
 
Email Options:    ( Allows for advanced features to be activated with messages.   RC at bottom) 
 
 Importance, Sensitivity, Tracking, Delivery dated, Request Reply, Signature, Stationery, etc… 
  ( To add a signature then use Tools > Options > Mail Format…  ) 
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ListServ (Mailing List / Newsletter)  ListServ = List Server 

Subscribing to a ListServ: 
To:  Address of List Server Subject:  Blank 

   Body:   Subscribe     Name of List     Your Email Address 
-------------- 

Moderated Lists Filtered Emails  (Human) Less Email 
Unmoderated Lists Auto Emails (No Human) All Email 

-------------- 
Mailing Lists are Databases containing many Email Addresses & information on addressee 
 
UseNet (Newsgroups /  Bulletin Board)  
 Similar: to ListServ / dedicated to one topic  Differs: Choice of Messages 

Normally need special software (Newsgroup Reader) which is part of Email program 
-------------- 
Ten Main UseNet Topics:    Alt, Biz, News, Rec, Comp, Sci, Soc, Talk, Hum, Misc 
 Need an account to use BB (Network News Transfer Protocol) NNTP 
Threaded = Topic Expanded Thread = Re:  to initial posted message 
 
The Internet & WWW:  
 
Uniform Resource Locator (URL)  HyperText Marked Language (HTML) 

Web Server (http)  HyperText Transfer Protocol   
Hyperlink: words and/or images that connect to internal web pages and/or external web sites.  
---------------- 
Web Page Elements: 
Banner Ad = pays for page   URL =  http://www.netscape.com 
Field = Box to enter info   Button  = Graphic Interactive Icon 
Hyperlink = Text or Graphic    Status Bar = Progress 
Picture = Graphics or Photos   Domain Name or Internet Protocol (number) 
 
Browser: Microsoft Internet Explorer  Netscape Navigator/Communicator 
 Software application which communicated with any type of server on internet 
-------------- 
Path:   http:// www.malone.edu / tlove / default.html 
-------------- 
Web Site Types: 
Inform Public  Entertain Public Sell to Public  Survey Public 
 Product Awareness Educ Population Gather Info Solicit Support 
 
Online Databases  ( Search Engine Databases constantly updating information ) 
 Contain frequently updated info for web pages 
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***************************************** 
 

Learn the Internet & WWW for Novices 
http://www.learnthenet.com/english/index.html 

 
A comprehensive view of the Internet & WWW 

http://www.sofweb.vic.edu.au/internet/intro.htm 
 

***************************************** 
 

Information on & Learning about Email 
 

 Web Site 101  *  Email Tutorial  
http://www.website101.com/email_e-mail/ 

 
Gary Public Library Email Information 

http://www.gary.lib.in.us/email.htm 
 

Learn the Net– Email Tutorial 
http://www.learnthenet.com/english/section/email.html 

 
Digital Web Magazine – Email Information 

http://www.digital-web.com/tutorials/tutorial_1999-12.shtml 
 

***************************************** 
 

Information on & Learning about Chat  
 

The WURD – Tutorial on Chat 
http://www.wurd.com/eng/ABCs/tutorial/chat.htm 

 
Using EarthLinks AOL Instant Messenger 

http://support.earthlink.net/support/TUTORIALS/CHAT/chat_usingaim.jsp 
 

Learn the Net – Conference: Meeting, Chat, Phone 
http://www.learnthenet.com/english/section/conference.html 

 
Learning the Basics of Netscape Instant Messenger 

http://wp.netscape.com/support/books/netcenter/044000132.htm 
 

***************************************** 
 

 

http://www.learnthenet.com/english/index.html
http://www.sofweb.vic.edu.au/internet/intro.htm
http://www.website101.com/email_e-mail/
http://www.gary.lib.in.us/email.htm
http://www.learnthenet.com/english/section/email.html
http://www.digital-web.com/tutorials/tutorial_1999-12.shtml
http://www.wurd.com/eng/ABCs/tutorial/chat.htm
http://support.earthlink.net/support/TUTORIALS/CHAT/chat_usingaim.jsp
http://www.learnthenet.com/english/section/conference.html
http://wp.netscape.com/support/books/netcenter/044000132.htm
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